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Introduction

1

The Archive Manager Outlook Add-in offers end users the capability to archive, retrieve, restore

and search for archived email items directly from the Outlook client installed on their computers.

This guide describes the all these features and other capabilities of the Outlook Add-in.

NOTE: Native rehydration or exports are intended for small data sets. For operations on

large data sets, use a specialized utility such as Quadrotech Archive Shuttle (QAS).

When the Outlook Add-in is installed, the Archive Manager tab appears in the Outlook toolbar.

The various functions available in the toolbar ribbon are shown in the illustration below. For

more information about the installation and permission settings that control the functions in the

ribbon, see the Archive Manager for Exchange 8.10 Outlook Add-in Installation Guide.

When email items are archived, special icons are used to indicate the nature of the archived

email item as described in the table below:

Icon Description

Archived e-mail. A bold font indicates that the email is archived and unread.

Archived email that has been replied.

https://www.quadrotech-it.com/products/quadrotech-archive-shuttle
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Icon Description

Archived email that has been forwarded

NOTE: When you open Outlook for the first time after installing the Archive Manager

Outlook Add-in, it will take longer than usual because the Add-in is loaded and configured

automatically. When you open Outlook the next time, the interval will be shorter. The

Archive Manager toolbar is also listed in the File > Options > Customize Ribbon window. All

Outlook Add-in actions are logged to a log file located in the %AppData%\Quest

Software\Archive Manager\Log\Archive Manager folder.

Outlook® is a registered trademark of Microsoft Corporation. All features of the Archive

Manager Outlook Add-in are valid for Outlook 2016 and later.
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Archiving emails

2

You may choose to archive several e-mails or documents at once. When archived, emails will be

residing in the archive until its retention time elapses. The archived email can be even deleted

from Outlook, however, it will be still accessible e.g. via keyword search.

Steps to archive emails

1. Click  the Archive Manager addin.

2. Select one or more emails and click Archive from the ribbon. You can also archive emails and

documents from the Public Folders folder if you have the appropriate permissions which can

be assigned in Archive Manager for Exchange Administration Center (AMAC).

3. Choose a retention category from the adjoining drop-down box, which will be used when

archiving the selected emails. The retention category defines the period to retain archived

emails, whether the shortcut should be created and more. For more information on retention

categories see the Archive Manager for Exchange Administration Guide.

4. During the archiving process the Progress box opens.

5. After an email is archived it can be retrieved and opened by double-clicking the archived

email. It can take some time while Outlook retrieves the emails from the archive and you

might see the following popup window.
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Restoring archived emails

3

Archived emails can be restored from the Archive Manager Outlook addin.

Steps to restore archived emails

1. Click  the Archive Manager addin.

2. Select one or more archived emails and click Restore from the ribbon.

3. Click Restore in the Restore messages window that opens.

4. Delete from archive - select this check box to mark the selected emails in the archive for

deletion. They will be deleted from the archive when their retention period expires.

However, it is still possible to find these archived emails with the Search feature until they

are physically deleted from the archive when their retention period expires. If the check box

is not checked, the emails will be restored but will not be marked for deletion from the

archive. The shortcuts of the email will be replaced on the MS Exchange Server with the

original email. 
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5. When the restoration starts the Progress window opens.

NOTE: If you delete archived emails from your mailbox using the Outlook's Delete action, it

is still possible to find them with the Archive Manager addin Search feature. However, only

the Archive Manager administrator can restore them back into the mailbox.



10
Deleting archived emai ls

Quest® Archive Manager for Exchange Outlook Add-in User Guide 

Deleting archived emails

4

With this menu option the archived e-mails are deleted from the Exchange Server. They can also

be marked for deletion from the archive and consequently, they will be deleted when the

retention period expires.

Steps to delete archived emails

NOTE: To ensure the delete process is successful, you must deactivate the Cached

Exchange Mode in Outlook.

To deactivate Cached Exchange Mode in Outlook:

1. Click File > Account Settings > Account Settings.

2. Click the Exchange or Microsoft 365 account from the Email tab, and then click Change.

3. Under Offline Settings, uncheck Use Cached Exchange Mode. If you're a Microsoft 365

subscriber, uncheck Use Cached Exchange Mode to download email to an Outlook data

file.

4. Exit, and then restart Outlook.

Alternatively, you can keep Cached Exchange Mode activated and set Mail to keep offline

(or Download email for the past for Microsoft 365 subscribers) to a date range greater than

the received emails being deleted.

1. Click  the Archive Manager addin.

2. Select one or more archived emails and click Delete from the ribbon.

3. In the Delete from archive window, click Delete.
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4. By not selecting the Delete from archive check box only the email shortcut will be deleted

from the Exchange Server. However, the email will not be marked for deletion in the archive

and the email is displayed as lost in the Archive Manager Administration Center (AMAC). It can

be restored by the administrator during its retention period or until the Shortcut

synchronization job runs. For more information see the Archive Manager for Exchange

Administration Guide.
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Search

5

In this chapter:

· Keyword Search

· Advanced Search

· How to build search queries

Keyword Search

Keyword search is used for searching through archived emails and attachments. It is possible to

search for text in pictures (OCR search) although this technology has some limitations. For

example, tiny text may not be correctly recognized. Keyword search can be used for searching

through archived and subsequently restored mails. 

Steps to run a keyword search

1. Click  the Archive Manager addin.

2. Click Search from the ribbon.

3. The Search window opens.
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4. Enter the keywords in the Search for the word(s) field. The keyword is searched in the subject,

email body and attachments.

5. The result of the search is then displayed in the Search results window.

6. From the the Search results window, you can retrieve an archived email by either selecting the

email and clicking Display or by double-clicking the email.

Search Expressions

Search expressions are a combination of keywords and logical operators that enhance the search

capability. Keywords can be used in combination with the logical operators AND, OR. The

operator AND is not mandatory. If no logical operator is included, the keyword search query

engine searches for documents containing all the given words.
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Example 1:

Search results for hello AND welcome are the same as search results for the string hello

welcome or welcome hello. When you intend to look for an exact phrase (a group of words that

functions as a single unit in the syntax of a sentence) you should use quotation marks " ". 

Example 2: 

Archive Manager Search supports other operators: NOT, + and -. Single and multiple character

wildcard searches are supported as well: 

Character Description Example

? single character wildcard; replaces any

single character

te?t matches text, test etc.

* multiple character wildcard; replaces

0 or more characters

test* matches test, tests, tester etc.

+ requires that the term after the "+"

symbol exist somewhere in a the field

of a single document

+test data

searches for documents that must

contain "test" and may contain "data"

NOT excludes documents that contain the

term after NOT. This is equivalent to a

difference using sets. The symbol !

can be used in place of the word NOT

Note: The NOT operator cannot be

used with just one term. For example,

the following search will return no

results: NOT "test server".

"test data" NOT "test server"

searches for documents that contain

"test data" but not "test server"

- excludes documents that contain the

term after the "-" symbol

"test data" -"test server"

searches for documents that contain

"test data" but not "test server"

NOTE: The above mentioned wildcard specification characters, i.e. ? or * etc., cannot occur

as first 2 characters of the search phrase. The search query as such cannot other contain

special characters as ":", "\", "!", "^", "~".

You can use the Save / Load buttons to save / load search criteria you have specified. It is

especially useful e.g. when you have set special settings for Advanced search (see further).



16
Search

Quest® Archive Manager for Exchange Outlook Add-in User Guide 

Advanced Search

Advance search lets you specify your search criteria in more detail. 

Steps to use advanced search

1. Click the plus (+) sign to expand the advanced search section. 

2. Click the Advanced tab.

3. Click Add new clause and enter the search criteria using the fields as described below:

a. Field - click the drop down to select the property of the email to be searched. For example,

select Subject as the field to search.

b. Operator - click the drop down and select a search operator.

c. Value - Specify the search text. If the selected Field requires a date value, a date picker

icon appears to help you choose a date. This field supports wildcard characters.

4. To add more criteria clauses, click Add new clause or . To remove a clause click . You can

additionally select the logical operator. The default operator is And.

NOTE: You can group clauses to create nested search criteria by selecting consecutive

check boxes and clicking the  icon.
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5. To view the scope of the search on mailboxes, click the Mailboxes tab. By default only the

current mailbox is added. You must select more mailboxes manually if you want to search

additional mailboxes.

NOTE: If you do not see additional mailboxes, the Administrator must follow the steps

below to expand the search scope to more mailboxes:

a. Open the Address Book Manager in the Archive Manager for Exchange

Administration Center (AMAC).

b. Click Mailboxes to open the list of mailboxes.

c. Right-click the mailbox you want to add and select Permissions from the context

menu. The Mailbox rights window opens.

d. Click Add and select the Outlook user who will run the search. Then click OK to close

the windows.

e. Open the Advanced search window again and click the Mailboxes tab to view the

additional mailboxes
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6. To set the search scope on email item types, click the Settings tab.

Configure the settings as described below:

a. Limit search results to - the number of emails that are returned in the search result list.

b. Search options allow you to specify the category of documents to search.

· No selection - only archived documents are searched. Previous versions of these

documents are not included.

Select one of the following options:

· Search in archived and deleted documents - all documents will be searched. Previous

versions of these documents are not included.

· Search in deleted documents - deleted documents and documents that are marked for

deletion will be searched. All other archived documents will be ignored. Previous

versions of these documents are not included.

Add an additional criteria:
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· Search in versions - Previous versions will be included for the document category

specified. The match will be shown for each version separately..

7. Click Search to search for archived emails based on the selection criteria, the mailboxes

specified and the settings that are applied.

8. Click Save to save the search criteria as an XML file. The saved search criteria does not include

the list of mailboxes used in the search scope. Click Load to load a previously save search

criteria.

How to build search queries
This topic describes how to build search conditions using the advanced search capabilities of

Archive Manager for Exchange. A search condition (or query) can contain zero or more search

clauses that are combined using operators and grouping of search clauses.

In this topic:

· Simple Conditions

· AND/OR operators

· Grouping

· Keyword Search

Simple Conditions

A simple search conditions needs no search clause or can contain just one search clause.
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Example 1

Click Search without adding a search clause. In this case, you will get back all the archived items.

Example 2

Add a single search clause with a condition where the field Subject contains the word "them”.

When you click Search, you will get back all the archived items where the Subject contains the

word "them".



21
Search

Quest® Archive Manager for Exchange Outlook Add-in User Guide 

AND/OR operators

The AND/OR operator is used between two search clauses. With these operators, you can

combine two or more search clauses. The AND operator will return a search result if both the

search clauses separated by the AND operator are fulfilled. The OR operator will return a search

result if any one of the search clauses separated by the OR operator are fulfilled. The AND

operator has a higher priority over the OR operator. When a search condition contains both the

AND and OR operators, the search clauses that are combined with the AND operator must be

fulfilled first.

Example 1

To find all items where the Subject contains word "them" AND the Sender is "amadmin", you

must combine two search clauses as shown: 

Example 2

To find all items where the Subject contains word "them" OR the Sender is "amadmin", you must

combine two search clauses as shown: 
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Grouping

Sometimes simple combinations of search clauses with the AND and OR operators are not

enough. Grouping is a good solution to change the priority between the operators. The grouped

search clauses have a higher priority than the operator before or after the group. The examples in

this section describe how the grouping works.

Example 1

To find all items where the Subject contains the word "them" AND the Sender is "amadmin", and

all these items must also have an attachment then the search condition is as shown:

Query: (Subject contains "them” OR Sender is "amadmin") AND has attachment
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We can split this search condition into two parts

1. (Subject contains "them” OR Sender is "amadmin”) which is a group

2. AND has attachment

Since a grouping has a higher priority, the search condition in the group must be fulfilled first. In

this case each item in the search result will have a Subject that contains the word "them” AND the

Sender is "amadmin”, and the item will also have an attachment

Example 2

To find all items where the Subject contains word "them” or, the Sender is "amadmin” and at the

item must have an attachment, then the query is as shown:

Query: Subject contains "them” OR Sender "admin” AND has attachment

This query can be split into two parts

1. Subject contains "them” OR

2. Sender is "amadmin” AND the item has an attachment

The AND operator has a higher priority so the search clauses combined with the AND operator

must be fulfilled first. In this case the search result will contain items where the item must have

an attachment and the Sender must be "amadmin”, or Subject should contain the word "them”.

Example 3

To find all items where the Subject contains the word "them" and the Sender is "amadmin”, or the

item has attachment, and the item must be in the "Inbox" folder then the search condition is as

shown:
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Query: Subject contains "them” AND (Sender is "amadmin" OR has attachment)
AND Folder path is "Inbox"

This query can be split into three parts

1. Subject contains "them” AND

2. (Sender is "amadmin” OR the item has an attachment)

3. AND Folder path is "Inbox”

The grouped search clauses have the higher priority in this query so the search condition in the

group must be fulfilled first. In this case the search result will contain items where the Subject

must contain the word "them” + Sender should be "amadmin” or the item has an attachment + the

folder path must be "Inbox”.

Example 4

To find all items where the Subject contains the word "them” and Sender is "amadmin”, or the

item has an attachment and these items should be in the "Inbox” folder then the search query is

as shown:
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Query: Subject contains "them" AND Sender is "amadmin" OR has attachment AND
Folder path is "Inbox"

This query can be split into two parts

1. Subject contains "them” AND Sender is "amadmin” OR

2. Item has attachment AND Folder path is "Inbox”

The AND operator has a higher priority in this query so the conditions with the AND operators

must be fulfilled first. In this case the search result will contain all items where Subject contains

the word "them" and Sender is "amadmin" or the item must have an attachment and the folder

path must be "Inbox".

Example 5

To find all items where the Subject contains word "them” or these items are in the "Inbox”

folder, and the Sender is "amadmin” or the item has an attachment, then the query is as shown:
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Query: (Subject contains "them” OR Folder path is "Inbox") AND (Sender is
"amadmin" OR has attachment)

This query can be split into two parts

1. (Subject contains "them" OR Folder path is "Inbox") AND

2. (Sender is "amadmin" OR item has attachment)

The grouped condition has the higher priority in this query so the conditions in the group must be

fulfilled first. In this case the search result will contain items where Subject should contain

"them” word or folder path should be "Inbox” + Sender should be "amadmin” or the item should

have an attachment.

Example 6

To find all items where the Subject contains the word "them" or, these items are in the "Inbox”

folder and the Sender is "amadmin", or the item has an attachment, then query is as shown:
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Query: Subject contains "them” OR Folder path Inbox AND Sender is "amadmin”
OR item has an attachment

This query can be split into three parts

1. Subject contains "them” OR

2. Folder path is "Inbox" AND Sender is "amadmin"

3. OR item has an attachment

The AND operator has a higher priority so the conditions with the AND operator must be fulfilled

first. In this case the search result will contain items where Subject must contain the word "them”

or folder path must be "Inbox” and Sender must be "amadmin” or the item has an attachment.

Keyword Search

Keyword search provides a fast and flexible search for keywords in the email Subject, body, and

attachments of messages in Archive Manager for Exchange. If you leave this field empty, then the

search result will show all archived messages. If you enter a word or phrase in the keyword field

and click Search the result of the search will show all the archived messages where the Subject,

body or attachment contains the entered word or phrase.

Example 1

You can combine keyword searches with advanced search clauses to find specific messages.

Keyword searches are combined with advanced search conditions with the AND operator. The

search result will contain items that have the keyword and the advanced search conditions as

well. To find all messages where the Subject, body or attachment contains word "mother" and

the Subject also contains the word "them", the search query is as shown:
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The body of the message contains word "mother", and the Subject contains word "them"

NOTE: To search in journal mailboxes:

· If a user has Journal permission set in ArchiveWeb then the user can search through their

own emails, where it is present as a kind of recipient (sender, recipient).

· If a user has Journal access granted through Archive Manager > Tools > Mailbox rights

manager, then the user can search all emails in the Journal.
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Versions

6

Each time you retrieve and edit an archived email a new version of that email is created in the

HSM Store. Versions are also created automatically when Archive Manager is configured to create

a delayed shortcut. For example if you have an email that is archived with a delayed shortcut, the

original email is still available in you mailbox even though it is marked to be archived. If you edit

and save this this email and it is eventually archived, a new version of the email will be created.

Different versions of an archived email can be checked in the Versions window.

Steps to work with the Versions window

1. Click  the Archive Manager addin.

2. Select an archived email and click Versions from the ribbon.

3. If the archived email has versions, then all the versions will be displayed in the list.

The actions you can perform in the Versions window are described below:

a. Display - opens the selected version of the archived email.

b. Create new copy - creates a new email based on the selected version. This newly created

email is not archived and you must archive it manually.

c. Restore - restores the selected version. The restored version of email will be retrieved and

deleted from the archive.

d.  - click the pin icon to keep the Versions window always on top while you work with

other applications. Click to  unpin the window.
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NOTE: 

· You can click any column header to sort the list based on the header.

· The keyword search engine searches for keywords in every version of the archived

emails. Search results may contain more than one version of the same email.

Steps to create a new version of an archived email

1. Open Outlook.

2. Double-click an archived email to retrieve and open the email in the Outlook message editor.

3. From the Message ribbon select Actions > Edit Message.

4. Revise the message as needed and save the message.

5. Click  the Archive Manager addin.

4. Select the edited archived email and click Versions from the ribbon to verify that a new

version was created and successfully archived.
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Offline synchronization

7

Working with archived emails is possible even when you use your MS Exchange Server mailbox

offline. Before switching to offline mode you must synchronize your Outlook mailbox with the

MS Exchange Server. If you also plan to work with your archived emails you must synchronize

with the Archive Manager addin as well. For automatic synchronization see Offline options.

Steps to synchronize archived emails for offline use

NOTE: To ensure the offline folder synchronization process is successful, you must

deactivate the Cached Exchange Mode in Outlook.

To deactivate Cached Exchange Mode in Outlook:

1. Click File > Account Settings > Account Settings.

2. Click the Exchange or Microsoft 365 account from the Email tab, and then click Change.

3. Under Offline Settings, uncheck Use Cached Exchange Mode. If you're a Microsoft 365

subscriber, uncheck Use Cached Exchange Mode to download email to an Outlook data

file.

4. Exit, and then restart Outlook.

Alternatively, you can keep Cached Exchange Mode activated and set Mail to keep offline

(or Download email for the past for Microsoft 365 subscribers) to a date range greater than

the received emails being deleted.

1. Run Outlook synchronization.

2. Click  the Archive Manager addin.

3. Click Offline Folder Synchronization.

4. When you reconnect wit MS Exchange Server online, you must synchronize your Outlook

mailbox with the MS Exchange Server. Then you must synchronize your Outlook mailbox with

the Archive Manager Server as well to update your Outlook mailbox with the current state of

all archived messages from the MS Exchange Server. 
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Options

8

In this chapter:

· Archive options

· Offline options

· Other options

Archive Options

1. Click  the Archive Manager addin.

2. Click Options to open the Options window.

3. Click the Archive tab.
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The properties are as described below:

a. Retrieve server - the Archive Manager server that is designated as the Retrieve server in a

distributed deployment. In a standalone deployment, the Archive and the Retrieve servers

are the same.

b. Archive server - the Archive Manager server that is designated as the Archive server in a

distributed deployment. In a standalone deployment, the Archive and the Retrieve servers

are the same.

c. https - select this check box if the communication protocol with the Archive and Retrieve

servers uses the secure https protocol.

d. Reset to default - Archive and Retrieve server values are reset to default values specified

during the addin installation.

e. Reset all settings - all settings across all tabs will be reset to default values.

Offline options

1. Click  the Archive Manager addin.

2. Click Options to open the Options window.

3. Click the Offline tab to configure automatic offline synchronization.

The properties are as described below:

a.  Auto synchronize when Outlook starts - select this check box to synchronize the Outlook

client with the Exchange sever when Outlook starts.
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b. Auto synchronize when Outlook exits - select this check box to synchronize the Outlook

client with the Exchange sever when Outlook exits.

c. Schedule offline synchronization every - select this check box to schedule offline

synchronization and specify the frequency in minutes. This is a useful option if network

interruptions are expected.

d. Show progress dialog - select this check box to display the progress dialog whenever the

scheduled offline synchronization runs.

4. Click Folder settings to open the Offline and cache settings window where you can manage the

addin cache and specify cache settings for each mailbox folder of the Outlook user.

The properties and actions are as described below:

Cache folder

a. Current location - indicates the location of the cache folder.

b. Click Settings to open the Cache folder settings window. Here you can set the global size

limit OR the global date limit for the cache folder. (Do not forget to check the Limit cache

by date check box if you want to apply the date limit.)
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Set the cache limits as described below:

NOTE: When reducing the cache size or date limit, the add-in will ask if you want to

delete the oldest items if the actual status of the cache exceeds the defined values.

i. Cache folder limit - drag the slider to set a size limit for the cache folder or set the limit

directly in the size counter. Size limits are defined in MB.

ii. Limit cache by date - select this check box to set the number of days the cache contents

will be retained. If this check box is checked the Cache folder limit is ignored. For

example, emails older than 730 days will not be cached during offline folder

synchronization. The user working offline will be able to see the shortcuts of all

archived emails but will be able to work with only those emails that were received in

last 730 days.

iii. Click OK to save the cache limit settings.

c. Click Clear cache to clear the cache folder.

Offline folders

a. Use Outlook's offline settings - select this check box to allow the add-in to synchronize

folders that are defined in the Outlook settings. Clear this check box to customize cache

limits for selected folders.

b. Custom limits for selected folders. The custom cache size and date limits defined for

individual folders are applicable only within the range of the global limits specified in the

Cache folder settings section as described above.

To set the cache size and limits:

i. Select a folder.
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ii. In the Limit folder area for the selected folder, select the check box for the cache size or

date or both, and set the limits.

iii. To manage subfolders  right-click a folder to select the options in the context-menu. For

example, if you set the date limit to 15 days for the Inbox folder and select the Apply

the same settings for subfolders option from the context menu then the same date

limit is set for every Inbox subfolder.

5. Click OK to save the settings and close the Offline and cache settings window.

Other options

1. Click  the Archive Manager addin.

2. Click Options to open the Options window.

3. Click the Other tab.

4. Choose the preferred language for the addin.
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Info

9

The Info feature presents information about the Archive Manager addin and allows you to

manage the addin connectivity.

Steps to work with the Info feature

1. Click  the Archive Manager addin.

2. Click Info from the ribbon.

3. The About Archive Manager window opens. This window displays the current version as well

as the current status of the addin.

4. Click Deactivate to disconnect the addin from the Archive Manager server. 

5. Click Reconnect to synchronize the addin with any changes changes made by the administrator

in the AMAC.

6. Click OK to close the About Archive Manager window.
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About Us
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Quest creates software solutions that make the benefits of new technology real in an

increasingly complex IT landscape. From database and systems management, to Active Directory

and Office 365 management, and cyber security resilience, Quest helps customers solve their

next IT challenge now. Around the globe, more than 130,000 companies and 95% of the Fortune

500 count on Quest to deliver proactive management and monitoring for the next enterprise

initiative, find the next solution for complex Microsoft challenges and stay ahead of the next

threat. Quest Software. Where next meets now. For more information, visit www.quest.com.

Contacting Quest
For sales or other inquiries, visit www.quest.com/contact.

Technical Support Resources
Technical support is available to Quest customers with a valid maintenance contract and

customers who have trial versions. You can access the Quest Support Portal at

https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and

independently, 24 hours a day, 365 days a year. The Support Portal allows you to:

· Submit and manage a Service Request

· View Knowledge Base articles

· Sign up for product notifications

· Download software and technical documentation

· View how-to-videos

· Engage in community discussions

· Chat with support engineers online

· View services to assist you with your product

https://www.quest.com
http://www.quest.com/contact
https://support.quest.com
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